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MERCURY IN TISSUE AND BIRD EGG 
 
 

1.0 SCOPE AND APPLICATION 
 

This is an atomic spectroscopy method for the determination of mercury in fish 
tissue. 

 
2.0 SUMMARY OF METHOD 
 

2.1 Fish tissue is digested with concentrated nitric acid. 
 

The mercury ions are reduced to elemental mercury with stannous chloride.  
The mercury vapor is analyzed by cold vapor atomic spectroscopy. 
 

2.2 The detection limit for this method is approximately 0.01 µg/g (ppm) (fresh  
weight), 0.05 µg/g (dry weight) for flesh assuming 80% moisture content for 
a 1.0 g sample. 

 
3.0 INTERFERENCES 
 

Certain volatile organic materials that absorb at this wavelength (253.7 nm) 
may cause interference.  A preliminary run without reagents should determine 
if this type of interference is present.  Chlorine causes severe interference. 
 

4.0 APPARATUS AND MATERIALS 
 

4.1 Digestion tubes: polypropylene digestion vessels - Cat. # SC499 or SC500 
from Environmental Express 

 
4.2 Ribbed watch glass - Cat. # SC505 from Environmental Express 

 
4.3 50 ml Rohre/Tube - Cat. # 62.559 from Sarstedt (Aktiengesellschaft & Co)  

 
4.4 15 ml Rohre/Tube - Cat. # 62.554.01 from Sarstedt (Aktiengesellschaft & 

Co)  
 

4.5 Filter papers - Cat. # 1004 090 from Whatman, for use if filtration is needed 
for the sample 

 
4.6 Hot block for metals digestions - Cat. # SC154 from Environmental Express 

 
4.7 Teflon spatulas 

 
4.8 Mercury lamp 
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4.9 Compressed argon – instrument grade 
 

4.10 Atomic Spectroscopy Perkin Elmer equipped with: flow injection mercury 
system 400 (FIMS 400), data system, programmable autosampler (AS-90 
series).    

 
5.0 REAGENTS 
 

5.1 Type II water 
 

5.2  Stannous chloride dihydrate, crystal (“Baker Analyzed” JT3980-11), 25%                                     
SnCl2*2H2O in 20% HCl.  Dissolve 50g SnCl2*2H2O in 40 ml HCl.  Mix and 
allow to stand until SnCl2*2H2O has dissolved and solution is clear.  Bring to 
volume (200 ml) with type II water.  PREPARE FRESH DAILY.  
(approximately 800 ml needed for the set of 32 tubes of sample, 5 tubes for 
standard curve and quality control) 
 

5.3  Mercury Standard Solution (stock) – J.T. Baker, 1000 ppm 
 
5.4 Mercury Standard Solution (intermediate) - 1.0 ppm in 1.0% nitric acid.    

Partially fill a 1000 ml volumetric flask with Type II water.  Add 1 ml of 1000 
ppm HgCl2.  Bring to volume (1000 ml) with Type II water. 

  
5.5 Mercury calibration standards: Partially fill each volumetric flask with Type  

II water, add the appropriate volume of 1.0 ppm HgCl2 standard and 40 ml 
concentrated nitric acid and bring to volume with Type II water.  As solution 
cools, it will be necessary to add water to keep level at 100 ml.  Mix well. 
 
 0.0010 ppm:  Add 0.10 ml of 1.0 ppm HgCl2  
 0.0050 ppm:  Add 0.50 ml of 1.0 ppm HgCl2 
 0.0100 ppm:  Add 1.00 ml of 1.0 ppm HgCl2 
 0.0250 ppm:  Add 2.50 ml of 1.0 ppm HgCl2    
 0.0005 ppm:  Add 5.00 ml of 0.01 ppm HgCl2  
 

5.6 Mercury Check Standard and Spike Standard: E.M. Science, 1000ppm. 
 
5.7 Intermediate solution (A): 100.0 ppm in 1.0% nitric acid.  Partially fill a 100 

ml volumetric flask with Type II water.  Add 10.0 ml of 1000 ppm HgCl2 .  
Bring to volume with Type II water.  

 
5.8 Intermediate solution (B): 1.0 ppm in 1.0% nitric acid.  Partially fill a 100 ml  

volumetric flask with Type II water.  Add 1.0 ml of solution (A).  Bring to 
volume with Type II water. 
 

5.9 Check Standard: 0.010 ppm in 40% nitric acid.  Partially fill a 100 ml  
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volumetric flask with Type II water.  Add 1.0 ml of solution (B).  Bring to 
volume withType II water.  
 

5.10 Hydrochloric acid (HCl), concentrated, reagent grade. 
 
5.11 Nitric acid (HNO3), concentrated, reagent grade. 
 

6.0 SAMPLE COLLECTION, PRESERVATION, AND HANDLING 
 

6.1 All samples must have been collected using a sampling plan that addresses     
the considerations discussed in this manual. 
 

6.2 All sample containers must be prewashed with detergents, acids, and Type II  
water.  Plastic and glass containers are both suitable.  
 

6.3 Nonaqueous samples shall be frozen, when possible, and analyzed as soon as  
possible. 
 

7.0 PROCEDURE FOR SAMPLE PREPARATION 
 

Preparation of samples: 
 
7.1 Before weighing samples, prepare lab book (i.e. list samples and any special 
       instructions). 
 
7.2 Balance calibration should be checked and recorded using more than one 

weight in order to bracket the sample weight.  Thus, for a 0.5 gram sample, 
calibrate balance with 0.2 gram, 0.5 gram and 1.0 gram weights. Include date 
and operator’s initials.  

 
7.3 With each set of analyses, prepare at least 1 method blank prepared from the 

rinse water from the Buchi Mixer-B400 Grinder or a routine method blank if 
the grinder is not used, 2 standard reference materials (~ 0.25 g dry tissue - 
Dorm 2 or NBS 1566a), 2 matrix spike, 2 laboratory control spike, and one 
duplicate for every 10 samples. 
 

7.4 Samples with equal weight of water added: Place 2.0 ± 0.05 g into clean  
digestion tube. 
 

7.5 Samples without added water:  Place 1.0 ± 0.05 g into clean digestion  
tube. 
 

7.6 Add 10 ml concentrated nitric acid and let stand overnight. 
 
7.7 The next day, digest samples in a programmable hot block.  The parameters 

for heating are as follows: 
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Ramp: 50 C / min. 
Set the temperature to 105-1080 C to achieve a temperature of 95 Celsius 
(actual) in the hot block. 
Hold: 2 ½ hours 

7.8 Allow the tubes to cool, then add Type II water to the calibration mark  
(25ml).  Shake the samples 20 times to mix well. Filter the sample through a 
20-25 um if necessary to remove particulate. 

  
 7.9  Moisture Determination, if required 
 
  1.      Use only forceps to handle the aluminum weighing dish.   
 
  2. Number an aluminum weighing dish to correspond to the sample 

beaker number. 
 
  3. Weigh the aluminum weighing dish and record its weight. 
 
  4. Tare the aluminum weighing dish. 
 
  5. Weigh ~ 3g (minimum 1g) tissue and record the weight.   
 

6. Place moisture samples in a 70oC oven for 24 hours (Nguyen, 
2003). 

 
  7. After cooling samples, weigh and record the dry weights. 
 
Percent Moisture Calculation 
 
  (Dry sample weight   
  plus aluminum dish)         -         (Aluminum dish weight)                                    
1 - ____________________________________________ x 100 
 
    (Wet sample weight)   X   (F) 
 
   F = the added water factor = 0.6666 when added water equals one 

half of  
          the sample weight (i.e. flesh samples - Selenium Verification 
          Program) 
 
               =  0.5 when added water equals 

the sample weight (i.e. flesh 
samples - Toxic Substance 
Monitoring Program) 
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               =  1 when water was not added 

to the sample (i.e. liver and 
sediment samples) 

 
8.0 ANALYTICAL PROCEDURE 
 

8.1 Prepare reagents: 
 

8.1.1 25% SnCl2 (see Section 5.2) 
8.1.2 Rinse water -3.0% HCl (Prepare 1000 ml: 30 ml HCl add to 970 

ml Type II water) 
8.1.3 Reagent blank solution - 40% HNO3 (Prepare 500 ml: 200 ml 

HNO3 add to 300 ml Type II water)   
8.1.4 Calibration standards (see Section 5.5) 
8.1.5 Check standard (see Section 5.9) 
 

8.2 Transfer calibration standards and check standard to 50 ml Rohre/Tube,  
samples to 15 ml Rohre/Tube.  The tubes should be numbered to correspond 
to sample number. 
 

8.3 Operation of FIMS 400 and auto sampler 
 

8.3.1 Switch on the fume ventilation system, then the carrier gas supply 
(argon), adjust the pressure to 52 psig and finally switch on FIMS 
400. 

 
8.3.2 Switch on the computer, printer and start Windows. 

 
8.3.3 In the Program Manager, double-click on AA 2.50.  

 
8.3.4 When ”AA WinLab” appears, proceed as follows: 

 
•  From the Tools menu, choose Open ► Workspace, or on the 
    Toolbar, click on WkSpace. 
•  Select hgtissue.fms, then click on OK.  The window appears.      
•  On the Toolbar, click on MethEd.  Select Tissue Hg Test.  All  
    of the desired parameters have been entered for 
 
 Inst – Instrument parameters 
 Calib – Calibration parameters 
 FIAS – FIAS program instructions 
 Checks – Analytical checks for sample and calibration  
 solutions 
 QC – Locations of quality control solutions and instructions 
 for performing quality control procedures 
 Options – Remarks about the Method and options for  
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 saving and printing data  
•  Saving a method: From the File menu, choose Save As ► 
    Method.  A dialog appears.  If you want to save the Method  
    under a new name, type a name for the file, then press Enter 
    or click on OK.  To save the Method with the original name, 
    press Enter or click on OK. 
•  Click on SampInfo on the Toolbar to enter the pertinent  
    information (e.g. description, batch ID, analyst, the first  
    sample ID should be at auto sampler location # 9). 
•  Saving a sample information file: From the File menu, choose 
    Save As ► Sample Infor File.  A dialog appears.  If you want to  
    save the Sample Infor File under a new name, type a name for  
    the file, then press Enter or click on OK. 
•  Printing the Autosampler Loading List: From the File menu,  
    choose Print ► Autosampler Loading List. 
•  Select the name of the Results Data Set where you will save  
    the results.  If the data set exists, new data will be added to it. 
•  Select the Save Data check box if you want the results saved in  
    the data set specified. 
•  Select the Print Log check if you want the results to be printed. 
•  Select the Off After Analysis: Lamp, Pumps check boxes to              
    switch these items off at the end of the analysis. 
•  On the Automated Analysis window, check on “use Entire  
    Sample Infor File” column. 
•  Click on the tab containing “Analyze”: click on “Analyze all”             
    after the reagents have been prepared, the signal has been         
    optimized, the FIMS 400 flows have been set, the autosampler 
    has been turn on, and the samples have been loaded.  

 
8.3.5 To optimize the signal 
 

•  If  the absorbance for the first replicate is higher than that for     
the  subsequent ones, lengthen the Fill step on the FIAS page of 
the Method.  If the absorbance of the first is replicate is lower,            

    Lengthen the Prefill step. 
•  Ensure that the Read Delay (0 s) and Read Time (15 s) values 
    are set correctly on the Inst page of the Method. 
•  Slight adjustments to the gas flow may improve sensitivity.  If  
    the peak maximum appears too early, slightly decrease the  
    carrier gas flow.  If the peak maximum appears too late, slightly 
    increase the carrier gas flow. 
Note: If the carrier gas flow is too high, the mercury vapor is  
    dispersed too rapidly.  If the flow is too low, mercury vapor 
    flows into the cell too slowly.  In both situations the signal and 
    sensitivity are low.  A flow in the range 40-70 ml/min is  
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    generally suitable. 
•  A slight decrease in the outflow from the gas/liquid separator  
    may improve sensitivity. 
Note: If the outflow from the gas/liquid separator is too high,  
    mercury vapor may escape through the waste outlet.  If the out- 
    flow is too low, the fluid level may rise so high that moisture  
    escapes into the sample transfer tube and the FIMS-cell.  If  
    liquid does enter the FIMS-cell, you must clean the cell as  
    described in FIMS: Installation, Maintenance, System Descrip- 
    tion. 
•  Slight adjustments to the carrier and reductant flows may  

                                        improve sensitivity. 
If the FIMS-cell is contaminated, e.g., you must clean the cell as 
described in FIMS: Installation, Maintenance, System 
Description. 

 
8.3.6 To set up the FIMS – 400 
 
            •   The carrier gas stream has a large influence on sensitivity.  If  
                 the flow is too high, the atom or hydride cloud is dispersed too 
                 rapidly.  If the flow is too low, the resulting signal and sensitivi- 
                 ty are lower.  A flow of 50-100 mL/min for the carrier stream is            
                 suitable.  If there is no gas flow, the automatic gas valve may be         
                 closed.  To start the flow, in the FIAS Control window, click on 
                 Valve Fill/Inject. 
            •   Place the inlets of the carrier pump tube (yellow/blue), reduct- 
                 ant pump tube (red/red) and sampling tube (leading to the FIAS 
                 valve) in containers of deionized water. 
            •   Swing the pump pressure levers over to press the pump tube  
                 magazines against the rollers. 
            •   On the Toolbar, click on FIAS.  Then, in the FIAS Control win- 
                 dow:  
                 ♦ Click on Valve Fill/Inject to set the valve to the Fill position. 
                 ♦ Type 100 for Pump # 1 Speed, and type 120 for Pump # 2    
                     Speed. 
                 ♦ Click on Pump # 1 and Pump # 2 to start the pumps. 
            •   The flows should be checked before every run.  When checking  
      flows, only use P-2. P-1 is dry except when sample is being  

                               pumped.  The carrier pump tube (yellow/blue) should have a                                   
flow of 9-11 ml/min; the reductant pump tube (red/red) should                                
have a flow of 5-7 ml/min.  It is recommended that the tubes be 
replaced after two runs and that they are reversed when they are 
run the 2 nd time.  

            •   After setting the flows, position the reagents. 
 •   For gas/liquid separator, put filter paper’s shiny side up 
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8.3.7 Sample Changer 

 
                                    •   Load the sample carousel with standards, reagent blank solution       
                                         and samples. 
                                    •   Set in place the rinse solution (MQ H2O) at location 0. 
 

8.3.8 Initiate the run 
 
            •   On the Toolbar, click on Analyses, select Autozero signal to  
                 zero the instrument. 
            •   To analyze all the solutions: In the Automated Analysis Control  
                 window, click on Analyze All.   

     All the solutions will be analyzed.  The calibration solutions  
     will be analyzed first, immediately followed by the samples and  
     any other solutions (QC, reslope etc.).  

 
PRECAUTIONS: 

Check that the drain tube is connected to the gas / liquid separator 
and freely drains into collection vessel.  The end of the drain tube 
must not be submerged in liquid.  The exhaust hood over the FIMS 
should be left on at all times. 
 

8.3.9 Post run: Rinsing procedure after automatic analyses 
 

•  Place the inlets of the carrier and reagent (e.g. reductant, buffer) 
     tubes in a container of deionized water.   
•   On the Toolbar, click on Auto. 
•   In the Automated Analysis Control window, click on Analyze        
    page tab. 
    ♦ Click on Select Location.  In the dialog box, select the Go to       
         wash option, then click on OK.   
    ♦ In the Automated Analysis Control window, click on Move  
         Probe Up/Down to raise the sampling probe. 
    ♦ Place a beaker with the first rinse solution in the wash  
         location (usually location 0). 
    ♦  Click on Move Probe Up/Down to lower the probe into the  
         rinse solution. 
 •  On the Toolbar, click on FIAS. 
 •  In the FIAS Control window: 
    ♦ Click on Valve Fill/Inject to turn the valve to the Fill   
          position.  (The position is shown in the Status display of the  
          window.) 
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 •  In the FIAS Control window: 
    ♦   Click on the Pump 1 and Pump 2 buttons to start   

 the pump.   
                 ♦  In the FIAS Control window, click on Valve Fill/Inject a  
                                               number of times while the pumps are running.  This ensures  
                                               that sample channel and the inside of the FIAS-valve are  
                                               rinsed effectively. 
                                               Rinse the tubing with the deionized water for as long as  
                                               necessary to remove all traces of the previous reagent. 
                                    

8.3.10 Quality Control 
 

•  All quality control data should be maintained and available for    
    easy reference or inspection. 
•  Calibration curves must be composed of a minimum of  
     three standards.  After running the calibration curve, analyze   
    an initial calibration blank and an initial calibration check   
    standard (ICB, ICV).  A continuing calibration blank (CCB) and       
    a continuing calibration check standard (CCV) should be 

analyzed every ten samples.  This check standard is used to 
check the validity of the calibration curve standard and therefore 
should be obtained different vendor.  The CCV result must be 
within 80-120% of the expected concentration.  After the last 
sample in the run, a final FCB and FCV should be analyzed. 

  •  Dilute samples if they are more concentrated than the highest   
     standard. 
  •  Analyze a minimum of one blank per sample batch to  
      determine if contamination or any memory effects occur. 
  •  Analyze two standard reference material (SRMs) of a                              
      comparable matrix with each set of samples. 
  •  Analyze on duplicate sample for every ten samples.  
  •  Analyze a matrix spike (MS) and matrix spike duplicate (MSD)  

         with each run.  If the percent recovery for matrix spike is  
        unacceptable, there might be an interference due to the      
                              matrix.  Dilute the sample to lower the interference and analyze  
                              the sample again.  If it doesn’t work, use standard addition. 

  •  Analyze a laboratory control spike (LCS) and laboratory  
     control spike duplicate with each run.   

 
 9.0       ACCEPTANCE CRITERIA  

 
 9.1 The correlation coefficient for the calibration curve must be 0.995 or 

greater. 
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 9.2 The recovery of the standard reference material must be within 70% to 

130% of the 95% confidence interval for the reference material. 
 
 9.3 Relative percent difference of sample duplicates must be within 15% for 

sample values greater than 30 times the MDL.  An RPD between 
duplicates of 25% will be permitted if the sample value is greater than 5 
times the MDL but less than 30 times the MDL. An RPD between 
duplicates of 25% will be permitted if the sample value is less than 5 times 
the MDL. 

 
 9.4 Recovery values for sample spikes must fall within 80% to 120%. 
 
 9.5 Blank values must not exceed 3 times the MDL. 
 
 9.6 The recovery of the laboratory control standard (LCS) must be within 80% 

to 120%. 
 
10.0 CORRECTIVE ACTIONS 
 
 10.1 If the recovery for the standard reference material is unacceptable, the 

analysis must be terminated, the problem corrected and the samples 
reanalyzed. 

 
 10.2 If the precision falls outside of the acceptable range, the analysis must be 

terminated, the problem corrected and the previous samples associated 
with that duplicate reanalyzed.  If duplicate results are out side of the 
acceptance range, all pertinent data for samples associated with that 
duplicate sample will be flagged. 

 
 10.3 If the recovery of the matrix spike is outside of the acceptance range, the 

spikes will be diluted and reanalyzed. If the spikes still do not pass the 
acceptable quality control range an external spike will be performed if the 
digested LCS has passed criteria. 

 
 10.4 If the blank value exceeds 3 times the MDL, the analysis must be 

terminated, the problem corrected and the previous samples associated 
with the blank reanalyzed. 

 
 10.5 If the recovery of the LCS is outside of the acceptance range, the LCS will 

be reanalyzed. 
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